ABSTRACT
The bq20z70/90 evaluation module (EVM) and its corresponding evaluation software provides a rich and effective environment for examining the bq20z70/90 – a new, advanced battery gas gauge. This application report covers this EVM and software with an emphasis on how to use it and what to expect. EVM board connections are discussed in detail, and helpful hints are offered. For the evaluation software, components of each major screen are presented along with the various menu options.

Contents
1 Connecting the EVM ................................................................. 1
2 Scanning the SBS Registers ...................................................... 3
3 Logging the SBS Registers .......................................................... 5
4 Editing the Data Flash ................................................................. 6
5 Calibrating the bq20z70/90 ............................................................ 8
6 The Pro Screen ......................................................................... 9
7 EVM Schematic ...................................................................... 11

List of Figures
1 bq20z90 EVM Connections .......................................................... 2
2 All Flags and Status Bits Are Visible on a 1024x768 Screen if the Top Display Buttons Are Hidden ......................................................... 4
3 Vertically Tiled View of SBS, Data Flash, and Pro Screen ................. 5
4 Example of bq20z70/90 Data Flash Organization. 1st Level Safety Class of Data Flash Constants. Subclasses are Voltage, Current, Temperature, and Host Comm. ..... 7
5 Pro Screen ............................................................................... 9

1 Connecting the EVM
The cell-connection terminal blocks provide screw terminals for connecting 2, 3, or 4 cells to the evaluation module (EVM). The numbering convention for batteries is that Cell 1 is the most negative; so, connect the 1N (N=negative) terminal on the EVM to the most negative point of your battery stack.

If evaluating a 3-cell application, connect both 3P and 4P (P = positive) to the top node of the cell stack. Similarly, for a 2-cell application, connect 2P, 3P, and 4P to the top node.
1.1 **Cells, Resistors, or Power Supplies?**

For quick evaluation of the bq20z70/90 safety features, using real cells can be a burden. Therefore, substitute a string of 1-kΩ resistors fed with a single laboratory power supply. The supply can be varied quickly to investigate pack voltage protection. An additional floating supply can be connected across one of the resistors to simulate cell over- and undervoltages.

However, be aware that the Impedance Track™ algorithm, which relies on measuring the actual cell impedance, does not operate correctly without real cells.

1.2 **Where is the Fuse?**

The EVM does not include the chemical fuse that is employed in many battery pack applications. This eliminates the need for fuse replacement when running fault tests. Instead, the signal on the fuse test point is the control signal that would blow the fuse. It requires an external pullup resistor to the battery voltage in order to monitor its state on a scope or meter.
1.3 System Present and Pack Connections

The Pack+ and Pack– connections are used to connect the load and charger. It may be convenient to simultaneously connect a laboratory power supply and an electronic load in parallel. Most electronic loads have a load on/off switch and adjusting the constant current limit control to zero can disable the laboratory power supply.

1.4 Simulating Current

If using a string of resistors to simulate cells, it is difficult to apply an actual charge current. The solution is to connect a floating laboratory power supply between Pack– and Battery– (1N). Putting the floating supply in current limit provides a simulated charge current that is forced through the sense resistor. Depending on the laboratory power supplies available, this configuration can be useful for load current by reversing the polarity of the current source connections. Use this configuration to quickly test various overcurrent safety features or to validate coulomb counting accuracy. However, be aware that this method bypasses the protection FETs, and fault conditions will not interrupt the charge or load current.

1.5 Simulating Temperature

Because the temperature measurement works by measuring the voltage on the thermistor pin, a temperature chamber for safety evaluation is unnecessary. Just connect a laboratory power supply across the RT1 terminals with polarity as shown in Figure 1 (see the EVM schematic located at the end of this document). In this case, this power supply does not have to be isolated from the supply used to simulate a charger/load because the return side of the thermistor is the same as Pack–. Forcing 0 V ~ 2 V across the thermistor allows testing the safety features over the full temperature range.

2 Scanning the SBS Registers

With the battery connections made, start the evaluation software. When first connected, the circuitry may be in shutdown mode. This normally requires applying a charging source across the Pack+ and Pack– terminals. If a charger voltage is not connected, briefly connect the positive battery voltage to Pack+.

2.1 Setting the Scan Interval

By default, the SBS register scanning is off. Put a check in the Keep Scanning box to get the scanning started. A periodic update of all the SBS registers should appear. Note the blue progress bar at the bottom. The interval between scans can be set in the Options | Set Scan Interval menu. The program remembers this setting and uses it each time the program is launched.

2.2 Adjusting the View

With some screen resolutions, it may not be possible to see all of the register displays simultaneously. In some cases, this can be improved by making the top buttons invisible. Use the View | Display Buttons menu to remove these objects from the screen (see Figure 2).

The Evaluation Software, EVSW, has the flexibility to allow multiple views. Two or three screens can be tiled onto the display at once. After opening any of the SBS, Data Flash, or Pro screens, use the Window menu to tile them either vertically or horizontally. Figure 3 shows a vertically tiled view of all three.
Figure 2. All Flags and Status Bits Are Visible on a 1024x768 Screen if the Top Display Buttons Are Hidden
2.3 Flags/Status Bits

The flags and status bit displays are bit expansions of the various status, alert, and battery mode registers. The red bit cells are asserted, whereas the green cells are not. The displayed mnemonics are an improvement compared to decoding hexadecimal digits, but consult the data sheet to learn the full definition for each bit.

3 Logging the SBS Registers

Due to the long time associated with battery testing, it is common to data-log complete charge and discharge cycles for later analysis. When evaluating a new cell type, or a new gas gauge device, logs provide a convenient and effective way to understand the process.

3.1 Configuring the Log File

The log file can be configured to record any combination of the displayed SBS and extended registers. Simply check or uncheck the items to log. Select or deselect all of them quickly using the Options menu. It is usually a good idea to deselect the registers that are not relevant to the experiment being performed in order to simplify the process of reading the log later and to reduce the size of the log file.

The logging interval is also configured from a dialog box available in the options menu. Consider the purpose for the log when choosing an interval. If you expect to see several events during a short period, or are looking for a transient phenomenon, then a short interval, such as 1000 milliseconds can be used. This produces a huge file when run overnight, so decrease the resolution if it is not really necessary.
Start and stop the logging process with the buttons near the top of the screen. The state of the Start Logging and Stop Logging buttons immediately reveal if the program is logging or not.

### 3.2 Using Excel for Log File Evaluation

The log file is written as records of tab delimited ASCII. This file format can be imported into Microsoft™ Excel without any extra steps. Just right-click on the file name, and select Open With | Microsoft Excel for Windows™. However, one problem that can arise is with columns containing hexadecimal values. If the data contains an "e", Excel interprets this as scientific notation by default. If this situation occurs, use the import function in Excel, and modify the column type for the target column to be "text."

Microsoft Excel has a function in its Window menu called Freeze Panes, which is extremely helpful for reviewing long lists of records. Highlight the first row of data, under the heading row, and choose Freeze Panes from the Window menu. Now you can scroll through the entire log and still see the heading for each column. Sometimes, it is more convenient to delete the header information in lines 1 through 11.

### 4 Editing the Data Flash

The data flash screen displays the classes and subclasses used to categorize the data flash constants. The classes are on the index tabs at the top. Select a tab to activate the display for all the constants within that class. The 12 data flash constant classes are 1st Level Safety, 2nd Level Safety, Charge Control, Gas Gauging, SBS Configuration, Ra Table, Pf Status, Calibration, System Data, Configuration, LED Support, and Power. Help text for each constant is available by right-clicking the mouse when the cursor is over the name.

#### 4.1 Navigating the Data Flash – Classes and Subclasses

The classes of constants are selected with the tabs; under each class are also subclass groupings. For example, click on the 1st Level Safety Tab. Shown in the grids are the various data flash constants with subclass indicators in bold type. In this case, the subclasses are Voltage, Current, Temperature, and Host Comm.
4.2 Reading and Editing Data Flash

Use the Read All button initially to populate the grids. Make a change to any constant in the value column, and press Enter to write the new value into the device data flash. Note that data cannot be written to the device if it is sealed or in a permanent fail state.

4.3 Exporting and Auto Export

A list of all the data flash values may be stored to a text file with a .gg extension. The format of this file includes the class, subclass, name, and value for each data flash location. For example:

- [Voltage(1st Level Safety)]
- COV Threshold = 4350
- COV Time = 2
- COV Recovery = 3900
- COV Delta = 20
- COV Temp. Hys = 100
- POV Threshold = 13000
- POV Time = 2
- POV Recovery = 12600
- CUV Threshold = 2500
- CUV Time = 2
- CUV Recovery = 3000
Calibrating the bq20z70/90

- PUV Threshold = 8200
- PUV Time = 2
- PUV Recovery = 9000

Note that the constants are grouped under subclass and class which are identified with a line of text in the format: [Subclass(Class)].

These files can be generated automatically at programmed intervals using the AutoExport feature. Use the Options menu to set the interval and the file name. Then, start the feature with the AutoExport menu command. At each programmed interval, a new .gg file is written, with an index number appended to the file name. This feature is useful for tracking data flash values that may change over time, such as the resistance values for each cell in the Ra Table.

4.4 Importing and Writing All

The .gg file can be saved and then imported into another device. Use the File | Import menu to select a .gg file. Doing this brings the data into the data flash grids, where it can be reviewed and edited. To transfer all the data into the bq20z70/90 gas gauge, push the Write All button.

5 Calibrating the bq20z70/90

The calibration screen provides a flexible platform for device calibration of offsets, voltage, current, and temperature. The common calibration functions and an optional pack voltage calibration function are available.

5.1 CC Offset Calibration

The coulomb current offset calibration is a prerequisite for voltage, temperature, and current gain calibrations, because a gain calibration with an offset present is not accurate. By default, this is a quick version of the offset calibration. A full calibration occurs each time the bq20z70/90 enters sleep mode. Although the various gain calibrations may be performed independently, the CC offset calibration must be performed at least once prior to use in order to correct for any CC offset error.

5.2 Voltage and Temperature Calibration

Enter the known value of voltage and temperature. Select the number of cells in the application. Select the type of temperature sensors used in the application.

5.3 Current Calibration

Enter the applied current, which should be approximately 2 A.

5.4 Pack Voltage Calibration

Pack voltage calibration is not generally necessary. This is used to calibrate a separate measurement path, which only detects if a charger is present.

5.5 Board Offset Calibration

Board offset calibration must be performed with the ICs powered only from the cells with no load current or charger connected.
6 The Pro Screen

Figure 5. Pro Screen

The Pro screen can be used to read and write low-level SMBus command, word, and block transactions (see Figure 5). There is also the ability to reprogram the bq20z70/90 flash memory. The write operations should not be done without understanding the implications.

6.1 SMB Commands, Words, and Blocks

SMBus commands, words, and blocks can be easily read or written on the Pro screen. The most common use of this facility is to send 0x0021 to SMB command 0x00 (Manufacturer Access) in order to start the Impedance Track™ algorithm.
6.2 SREC Programming

Programming or Re-flashing the bq20z70/90 is also an advanced topic, which can be useful in certain circumstances. The object files used to program the device have the extension .senc which refers to an encrypted s-record.
The schematics for the HPA059 and the HPA155 follow.
IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements, and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI's standard warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where mandated by government requirements, testing of all parameters of each product is not necessarily performed.

TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and applications using TI components. To minimize the risks associated with customer products and applications, customers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right, or other TI intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive business practice. TI is not responsible or liable for such altered documentation.

Resale of TI products or services with statements different from or beyond the parameters stated by TI for that product or service voids all express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. TI is not responsible or liable for any such statements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:

<table>
<thead>
<tr>
<th>Products</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplifiers</td>
<td>amplifier.ti.com</td>
</tr>
<tr>
<td>Data Converters</td>
<td>dataconverter.ti.com</td>
</tr>
<tr>
<td>DSP</td>
<td>dsp.ti.com</td>
</tr>
<tr>
<td>Interface</td>
<td>interface.ti.com</td>
</tr>
<tr>
<td>Logic</td>
<td>logic.ti.com</td>
</tr>
<tr>
<td>Power Mgmt</td>
<td>power.ti.com</td>
</tr>
<tr>
<td>Microcontrollers</td>
<td>microcontroller.ti.com</td>
</tr>
<tr>
<td>Low Power Wireless</td>
<td><a href="http://www.ti.com/lpw">www.ti.com/lpw</a></td>
</tr>
<tr>
<td>Audio</td>
<td><a href="http://www.ti.com/audio">www.ti.com/audio</a></td>
</tr>
<tr>
<td>Automotive</td>
<td><a href="http://www.ti.com/automotive">www.ti.com/automotive</a></td>
</tr>
<tr>
<td>Broadband</td>
<td><a href="http://www.ti.com/broadband">www.ti.com/broadband</a></td>
</tr>
<tr>
<td>Digital Control</td>
<td><a href="http://www.ti.com/digitalcontrol">www.ti.com/digitalcontrol</a></td>
</tr>
<tr>
<td>Military</td>
<td><a href="http://www.ti.com/military">www.ti.com/military</a></td>
</tr>
<tr>
<td>Optical Networking</td>
<td><a href="http://www.ti.com/opticalnetwork">www.ti.com/opticalnetwork</a></td>
</tr>
<tr>
<td>Security</td>
<td><a href="http://www.ti.com/security">www.ti.com/security</a></td>
</tr>
<tr>
<td>Telephony</td>
<td><a href="http://www.ti.com/telephony">www.ti.com/telephony</a></td>
</tr>
<tr>
<td>Video &amp; Imaging</td>
<td><a href="http://www.ti.com/video">www.ti.com/video</a></td>
</tr>
<tr>
<td>Wireless</td>
<td><a href="http://www.ti.com/wireless">www.ti.com/wireless</a></td>
</tr>
</tbody>
</table>

Mailing Address: Texas Instruments
Post Office Box 655303 Dallas, Texas 75265

Copyright © 2006, Texas Instruments Incorporated